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1. Welcome to Viewer

Benefits of using Viewer

Viewer is a very accurate separation viewer with a lot of extra production tools. It eliminates the need
for separated proofs and will help you to avoid bad plate-making.

You can preview the separations of your document as they would be produced by exporting the
document using Launch Workflow, and rasterizing it on an Esko FlexRip.

Note:

Separations shown in Viewer may differ from the final output when an alternative workflow is used.

Basic concepts

Viewer works with Press Settings. The Press Settings allow you to define press-specific
characteristics such as the first printable dot, dot gain, dot gain curves, and more.

After defining your Press Settings, you can generate an accurate separation preview.

In this preview, you have access to advanced tools such as the Densitometer, TAC Limit Preview,
Plate Preview, Print Preview and Registration Error Preview.

Fly-out menu options

A number of settings can be found in the Fly-out menu, by clicking the arrow at the top right of the
dialog.

Show in All Windows

Use this to apply the Viewer preview settings to all the open windows (when you used several
windows).

Merge Similar Inks

This option affects how a separation containing objects with different halftone information is
displayed in the separation list.

Leave it off to display a separate entry for each different halftone setting (as shown below at left), or
select it to display different halftone settings of the same separation as one entry (as shown below

at right).
b . Cyan B . Cyan
| [l Cyantt & [W] Technical
X li‘ Technical & Z Empty
& |Z Empty & I:‘ Unezolored
] I:‘ Ungalared

Default

Click Default to use the Default Press Setting. For more information, see Define Press Settings
Manage Press Settings...

Click this option to create, duplicate, edit or delete Press Settings. See Define Press Settings.
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2. Define Press Settings

Before you can start working with Viewer in a meaningful way, you should define your Press Settings.
Without basic information on the properties of the press you are using, Viewer cannot simulate
accurately.

You can open the Press Settings window by selecting Press Settings... in the fly-out menu

2.1 The Default Press Settings

If no Press Settings Folder is defined in the Viewer Preferences, a fixed setting will be used, and you
will not be able to change or create Press Settings. See Viewer Preferences.

In the list of Press Settings, there is always one Press Setting called Default, which you can edit
but not delete.

You can select it by selecting it in the Press dropdown in the Viewer dialog, and edit it using Press
Settings... in the fly-out menu

You can select it by clicking on Default in the Viewer dialog’s fly-out menu, and edit it using Press
Settings...

2.2 Creating a Press Setting

To create a Press Setting in Viewer:

Select Press Settings... in the fly-out menu .

Click New... in the Press Settings dialog.

Enter the name of the new press setting in the New dialog.
Click OK

> o bd =2

2.3 Copying a Press Setting

To copy (duplicate) a Press Setting:

Select it in the Press Settings dialog.

Click the Copy... button.

Give it a new Name.

Change its parameters as you wish (see The Press Settings in Detail).
Click OK.

o koo Dnd=
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2.4 Editing a Press Setting

To edit a Press Setting:

. Select it in the Press Settings dialog.
. Click the Modify... button.

1
2
3. Change its parameters as you wish (see The Press Settings in Detail).
4. Click OK.

2.5 Deleting a Press Setting

To delete a Press Setting:

1. Select it in the Press Settings dialog.
2. Click the Delete button.
3. Confirm that you want to delete it.

Attention:

Deleting Press Settings might also affect other workstations.

2.6 Choosing a Press Setting

¢ To select a Press Setting, click on it in the Viewer dialog’s fly-out menu.
e To select a Press Setting, select it in the Press dropdown in the Viewer dialog

2.7 The Press Settings in Detall

First Dot (%)

Specifies which minimal gray value (expressed in %) in the file still will yield a dot on the plate,
provided the RIP and platemaking occur under normal conditions.

Note:

Normal conditions indicate that the DGC must have been set up completely. The value does not
correspond with any measurement that has been made prior or during DGC set up, nor does it
correspond with any densitometer measurement on plate or on print. In fact, this value is (implicitly)
chosen by the person who set up the DGC and plate-making. Typical values range from 0.4% to
1.6%.
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Adobe lllustratorPlato uses 8-bit precision, yielding 256 different possible gray values. A single gray
value in an image may make the difference between a dot or no dot on a flexo plate. To allow for this
precision, Viewer uses percentages with one decimal digit.

8-bit gray value in lllustratorPlato Percentage
0 0.0%

1 0.4%

2 0.8%

3 1.2%

254 99.6%

255 100%

Note:

If you do not specify a first dot, you will not be able to use the following Viewer view modes for this
press setting:

¢ The Flexo Plate Preview
¢ The Flexo Print Preview

Dot Gain in Highlights

When you have specified a First Dot job percentage, you can also specify how dark it should actually
print. Enable Dot Gain In Highlights and specify the dot gain parameters:

¢ First Dot Prints As: indicates the dot gain for the first dot. Typical values range from 5% to 15%
depending on the substrate. The value is a job percentage, that will print on an ideal reference
press as dark as the first dot prints on this press.

¢ Range: while the previous value measured the amount of dot gain in the highlights, this value
expresses how far this effect penetrates into the midtones. Typically plate making is configured
in such a way that the mid-tones print like an offset press.

Note:

If you do not specify Dot Gain In Highlights, you will not be able to use the following Viewer viewing
mode: Flexo Print Preview.

Limited Total Area Coverage

The Total Area Coverage is the sum of percentages of the different channels on the same location.
A higher total area coverage means more of the various inks is printed on top of each other.

If you want, you can specify the Maximum Total Area Coverage to specify the maximum amount of
ink that the substrate can take on the same spot on your press.

Note:

Exceeding the Maximum Total Area Coverage for the press may cause drying problems, unexpected
color results, and other problems.
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Registration Error
Specifies the average maximum Registration Error on your press.

If you enable this option in the Press Settings, you can use the Registration Errors preview in Viewer
to check whether your trapping is sufficient to compensate for possible registration errors on the
press.

Moiré Settings

In the Moiré Detection settings of the Press Settings, you can define the default values for the settings
in the Moiré Detection window.

For more info on the different settings, see Moire Detection
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3. Generate the Preview

Before you can use Viewer, you have to generate a preview of the current document, based on your
specific Press Settings.

After you make changes to the document, you need to update the preview. This is reflected in the
Viewer palette: the Generate button changes to the Update button.

¢ C(Click the Generate or Update button to render a Viewer preview on your computer.
The preview is displayed in the Viewer palette once the rendering finishes.
You can also use the shortcuts:

e Command-+option+V (Mac) or Control+option+V (Windows) to open the Viewer window
e Command-+option+shift+V (Mac) or Control+option+shift+V (Windows) to generate / update
the Viewer preview

3.1 Navigating in the Preview

The Viewer window shows the preview of your document in the left pane, and the list of used inks
in the right pane of your Viewer palette.

At the bottom of the palette, you will find:

| [, B (A= B
2 3

1. azoom-in and zoom-out button and a dropdown menu with several zoom percentages, and two
extra zoom factors: fit artboard and fit graphics.

2. azoom-link button. When in link mode, the Viewer window will reflect what your Adobe lllustrator
Document window does.

3. a Densitometer (see Measure Ink Densities), Measure tool (see Measure Tool) and Zoom tool (see
below).

1. a Pan tool (see below), a Zoom tool (see below) and a Densitometer tool (see Measure Ink
Densities)

2. azoom-in and zoom-out button and a field showing the current zoom percentage.

3. the Refresh button.

4. the Minimize button.

Zoom in - zoom out

To zoom in the preview pane of the Viewer palette, select the zoom tool and just click, and the view
will zoom in using the clicked point as center point.

To zoom out, click while holding the ALT key pressed, and the view will zoom out using the clicked
point as center point.



E S K D :};;" | Viewer for llustrator

10

You can also drag a rectangle to zoom in, and the new viewport will be a closest match to the
rectangle you dragged.

To pan the view, hold down the spacebar and drag a line in the preview pane. The view will move
the direction and the length of the line you drag.

Note:

You can minimalize the user interface by selecting Hide options from the dropdown menu.

+ VIEWER

Show Options
=l _ _
|§ | Hide Trapping Layer(s)
=0 v Merge Similar Inks
>N Show All Separations
|§ O Press Settings...
e

[ B-[@ [ |
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4. The Viewer window

4.1 Viewing options

Options particular to certain Viewer previews are grouped under View Options. You can expand or
collapse them using the triangle beside View Options.

The following options are available in all Previews:

4.1.1 Separation visibility

In the Ink list, you can:

e C(Click the eye icon in front of a separation/color name to show or hide it.

e Click the eye button above the separations/colors list to show or hide all separations/colors.

¢ Click the ink name (not the eye button) to quicly hide all other separations and go in single-
separation mode.

¢ Alt-click an eye button to quickly hide all other separations and go in single-separation mode. Alt-
click the same eye button again to show all separations.

Note: If Show Technical Inks in the fly-out menu of the Viewer is enabled, Technical Inks are also
shown in this list. See also Technical inks in Viewer on page 21

4.1.2 Reverse Printing Order

Use the Reverse Printing Order button il to view how your file would look like with its ink order
reversed.

When Reverse Printing Ink Order is enabled (IT), it is always used in all windows, and a red arrow
icon is visible in the title bar of all the windows.

4.1.3 Orientation

The orientation buttons allow to change the orientation of the Preview of the job.

& | #l

This is applied to all windows when Show in All Windows is active, or only to the current window
when Show in All Windows is inactive.

g
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Note:

Keep in mind that this only changes the rotation of the preview, it does NOT actually rotate the job.

4.1.4 Measure Ink Densities

12

¢ To use the Densitometer, select Separations from the Viewer preview list, and click in the Viewer
preview window while holding down the ALT and CONTROL key (Windows) or ALT and Command
key (Mac).

¢ Press D to activate the Densitometer tool then click on an area of your document to measure the
separation densities in that area.

¢ Use the densitometer’s fly-out menu to choose how to view the results: Exact or Rounded.

¢ You can also choose to display your densitometer’s cursor in Black (default), Red, Green or Blue,
to improve it visibility on different areas of your file.

The densitometer will correctly measure through linework and images, even placed DCS2
multichannel images that normally cannot be measured in Adobe lllustrator.

Viewer is compatible with Xinet fullpress and Helios OPI systems and is able to show the high
resolution images stored on the OPI server.

The densities are shown to the right of each separation. The total density of all inks on the point that
is being measured (the TAC value) is shown at the bottom of the separation list.

|’E‘ . Process Cyan 76.1%
b4 . Process Magenta 100,05
@ || Process Yellow 94.9%
™ . Process Black 0.0%
@ [ Pantone 485 C 0.0%
® [ ] Pantone 116 C 100.0%

I 37L0% &

Note:

When the TAC value exceeds the TAC limit specified in the currently selected press settings, a
warning icon will be displayed next to the TAC value.
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Note: The percentages of technical Inks are not included in the TAC. See also Technical inks in
Viewer on page 21

4.1.5 Measure Tool

Measure tool helps you to measure the:

e Horizontal and vertical distance from the Adobe lllustrator axis zero point.
¢ Horizontal and vertical distance between first and second point.
¢ The total distance and the angle between first and second point.

To use the Measure Tool:

1.

|
Click the Measure tool on the Viewer pallet.

2. Click the first point and then click or drag to the second point on the Preview.

The following details are displayed on the right hand side;

e X: x-axis

e Y:y-axis

D: Distance between the first and second point.
W: Width

H: Height

A: Angle

X 47799 mm W 96,625 mm
¥- 125 8B4 mm H: 67,443 mm
Do 117,834 mm A 34.9 degr.

4.1.6 Scale Ink Densities

When viewing a document containing very dark overprinting areas (e.g. traps into dark colors) it is
sometimes difficult to examine the color composition of such areas in Viewer.

Therefore the Separations view mode offers a slider control to temporarily dim (= reduce the density
of) one or more selected separations.

For example: setting the density value to 50% will reduce the actual density values of the selected
separations by 50% when computing the composite (RGB) view.

¢ Select the ink(s) you want to dim in the ink list and use the Density (%) slider or the edit field to
scale down the density of the selected separations.

13
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4.2 Separations

14

The first viewing mode shows a list of all used inks.

Mode IEEIE

By default a separation is displayed in color. In order to see a separation as it would appear on film,
you can switch to “Show as Film: Positive”.

By switching to “Show as Film: Negative”, the visible separation will be shown in negative.

Note:

As both “Show as Film: Positive” and “Show as Film: Negative” are more useful on a single
separation, switching to one of those will show only one separation.

As both “Show as Film: Positive” and “Show as Film: Negative” are only useful on a single separation,
the Mode radio buttons are disabled if more than one separation is shown.

Highlight
Traps
This is not available in Plato
Transparency

This will highlight all objects that have an opacity percentage, a blend mode or an opacity mask
(regardless of what is underneath).

Overprint
Highlight Overprint will highlight the areas where an “overprint” setting in the paint style takes effect.
Screening Conflict

The Screening Conflict checkbox highlights areas where a screening conflict can occur. They can
occur if an object with transparency (opacity mask, opacity percentage or blend mode) is overlapping
on an object with another screening. The PDF definition clearly states that screening is always taken
from the topmost object, even if that object is completely transparent in some areas. In most cases,
this is not what you would expect.

In the example underneath, you can see a cyan rectangle, and a circle on top, with an opacity mask.
The objects have a different screening. Where the circle is on top of the cyan rectangle, the cyan
will take the screening of the blended circle. Therefore, as shown on the right, these areas will be
highlighted as Screen Conflict.
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Dim Artwork

When you enable an Highlight option, the document artwork is faded to the percentage you choose
in Dim Artwork

Color

When you enable a Highlight option, the objects are highlighted in the color you chose in the Color
Picker.

4.3 Color

This viewing mode shows a list of used colors.

views A
Presview: ICoIor j L
=+ [E =5 +[]»

- | [ crose), vi46) E
- | I s, Kitoos) ;I

- PA[20%), ¥(70%)

- | B3 Binks (2 PANTONE inks)

- | BB inks (2 PANTONE inks) e
- | BB Ginks [2 PAMTOMNE inks]
- | BE ginks 2 PANTONE inks] |

|z| Wigualisation of images is only correct using Ink Based Wiew

= View Options [Default)

4

Click the eye-icons in front of the colors to show or hide them.

Click the eye button above the colors list to show or hide all colors.

15
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4.4 Total Area Coverage

The Total Area Coverage (TAC) is the sum of all separation-densities at a certain point in your
document.

TAC Limit

The TAC Limit is the maximal Total Area Coverage that your document may contain. This value
depends on the press and the substrate your design will be printed on. Your printer should provide
you with the TAC Limit value to use.

Defining the TAC Limit

The TAC limit is defined in the Press settings. See Define Press Settings). By default the TAC Limit
is set to 270%.

Viewing areas over the TAC Limit

When you switch to the Total Area Coverage preview, the image in the preview pane will be dimmed
and all areas where the sum of the densities is higher than the TAC limit specified in the current Press
Setting will be displayed in 100% black.

ENEREY DRINN

16
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Note:

You can press the “D” key to activate the Densitometer Tool, and measure the actual TAC amount
in a specific area (see Measure Ink Densities).

You can Alt-Control-click (Windows) or Alt-Command-click (Mac) the black pixels to use the
densitometer tool, and to measure the actual TAC amount in that specific area. See Measure Ink
Densities.

To quickly see the maximum TAC in your document, use the TAC Limit slider.

Move the slider to the right to use a TAC Limit value higher than that used by your current Press
Setting. The more you move the slider to the right, the less pixels will typically be over the TAC Limit.

Note: Technical Inks are not taken into account. See also Technical inks in Viewer on page 21

4.5 Fexo Plate

If you change the Viewer Preview mode to Flexo Plate, a single separation (by default the first in the
list) will be shown as a simulated flexo plate.

Note:

In this Preview mode, only one separation can be viewed at a time.

Note:

Viewer uses the same technology as the Esko Flexo Tools for Photoshop.

17
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First Visible Dot

The Flexo Plate preview will use the First Visible Dot percentage from the press settings (see Define
Press Settings).

Pixels with a percentage lower than the First Visible Dot percentage will be shown as areas without
dots.

Pixels with a percentage equal or higher than the First Visible Dot percentage will be shown as areas
with dots.

Plate Color

The Flexo Plate preview predicts how clean your flexo plates will be. Especially in very light or very
dark areas, you could end up with isolated dots or holes on the flexo plate, and those areas are
difficult to hold on the plate or the substrate.

You can choose the plate color (Cyrel Red, Blue, Green or Safran Yellow, or a High Contrast
Blue&White) to match the type of plate you are using.

4.6 Flexo Print

This Viewer preview mode shows the effect of highlight dot gain on the image.

18
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-+ 5Iilﬂmins

This effect is equivalent to a curve adjustment. To determine this curve, the Flexo Print Preview will

use the First dot and the Dot gain in highlights settings from the Press Settings (see Define Press
Settings).

Going from light to dark:

¢ The Flexo Print Preview will display percentages below the First visible dot percentage as 0%.
¢ The First visible dot percentage will be shown using the First Dot Prints as percentage.

¢ Percentages above the First visible dot percentage will be shown darker.

¢ Towards the midtones this darkening effect will fade out until the Range value.

¢ Percentages above the Range value are displayed unchanged.

4.7 Registration Error

The Registration Error Preview is a simulation of a design printed with registration errors of a specific
press (defined in the Press Settings, see Define Press Settings). It can be very helpful to see if trapping
is applied sufficiently and correctly.

The Registration Error value is taken from the Press Setting you selected.

The separations are randomly shifted. In fact, all separations are moved exactly the distance of the
Registration Error, but all under a random angle.

If you want to see another random registration error simulation, click the Simulate Again button.

19
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In the example above, you can see a small area of a job in regular preview (left) and with registration
errors (right). In this case, you can clearly see no trapping was applied, so white lines appear at the
registration shifts.

4.8 Breakout

A Breakout is an area where the percentage of a single separation is lower than the First Visible Dot
value. This can be used to track areas that won’t show up on print because the values are too low.

Your printer should provide you with the First visible Dot value. The First visible dot is set in the Press
Settings: see Define Press Settings.When switching to Breakout mode, the preview will be dimmed
and all areas where a single separation has a value lower than the First Visible Dot value (but higher
than 0%), will be displayed in highlight color.

You can measure the actual percentages in that specific area using the densitometer (see Measure
Ink Densities).

20
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Note: Technical Inks are not taken into account. See also Technical inks in Viewer on page 21

4.9 Moire Detection

Moire Detection allows to detect possible screening problems (Moire) in the file.

You can set the options to highlight overlapping areas, to detect situations in which Moire might
occur:

e when the two overlapping areas have screening angles that do not differ 30 degrees.
¢ when the two overlapping areas have the same angle

¢ when the two overlapping areas have different rulings

¢ when the two overlapping areas have different dot shapes.

You can use the Ignore inks option to ignore inks that have

e adensity lower than a certain value,
¢ adensity higher than a certain value
¢ alLuminance higher than a certain value

as in all those cases, the Moire patterning will hardly be visible.

All these Moire Detection options are stored in the Press Settings. See Define Press Settings

Note: Technical Inks are not taken into account. See also Technical inks in Viewer on page 21

410 Technical inks in Viewer

By default, all technical inks are shown in Viewer, and rendered as opaque inks.

You can disable Show Technical Inks in the fly-out menu of the Viewer. In that case, technical inks will
not be shown in the Viewer, nor in the separation list. However, if a technical ink influences another
separation (e.g. if an object in a technical ink is knocking out the background), this will still be visible.

Even when shown, technical inks have no influence on the TAC limit, Breakout or Moire Detection.
See Total Area Coverage on page 16, Breakout on page 20 and Moire Detection on page 21

Technical inks are also not included in the total ink value below the separation list when measuring
a color. See Measure Ink Densities on page 12

21
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5. Viewer Preferences

22

Open the Viewer Preferences dialog by choosing Preferences > Esko > Viewer Preferences to set
one or more of the following options:

Image Display Quality:
Allows you to selected the preferred quality for displaying the contone images present in a document.
Following options can be selected:

¢ Low: Alow resolution preview image (< 72dpi) will be used (if present). When such preview image
is not available, a gray box will be displayed.

¢ High: A preview image of at least 150dpi will be used. When such preview image is not available,
a gray box will be displayed. This is the default option.

¢ Very High: If sufficient memory is available, the real data (not subsampled) of the image will be
displayed. When the image is too large to fit into memory (typically if the size is larger than 64MB)
a high resolution display image will be shown.

Anti-Aliasing: This preference offers control over the Anti-Aliasing method used to prevent display-
artifacts like rough (“blocky”) edges in rendered artwork.

Following settings are available:

e Off: Do not perform any anti-aliasing (default value, fastest).
¢ Low: Some anti-aliasing (slower).
e High: Highly accuracte anti-aliasing (slowest).

Note:

Setting Anti-Aliasing to “High” will result in high-quality preview at the expense of significantly slower
rendering / viewing speed (up to ten times slower than when Anti-Aliasing is turned off). It is advised
to only use the “High” setting on fast workstations (Macintosh with a 1.8 Ghz G5 processor or higher).

Densitometer Mode: This option lets you select the preferred resolution of the densitometer.
Following options are offered:

e Exact: Ink densities will be measured with an accuracy (resolution) of 1/255 percent. This
corresponds to the (8 bits per pixel) accuracy typically used by a Rip for outputting (unscreened)
separations. In other words what is measured will correspond “exactly” to the digital output of
the Rip.

¢ Rounded: Ink densities will be measured and presented with an accuracy of 1%. Densities with
a non-integral (e.g. 33.2%) value will be rounded to the nearest integral value (e.g. 33%).

If Densitometer Mode is set to "Rounded"”, the values shown in the Ink Coverage palette will also
be rounded.

Press Settings Folder: allows to define the folder from which the Press Settings should be loaded.

If no folder is set up, Viewer will try to use the default location: DeskPack Cont ai ner/
Set ti ngs/ Press. If there is no DeskPack Container mounted or available, then it will automatically
switch to User s/ Shar ed/ EskoAr t wor k/ Set ti ngs/ Press on Mac OS, or C. / User s/ Publ i c/
Docurent s/ EskoAr t wor k/ Set ti ngs/ Pr ess on Windows. The Viewer installer will automatically
create these folders.
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If no Press Settings Folder is available (e.g. the defined or default folder has been removed), you will
not be able to change or create Press Settings.

23
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o. Viewer Compare Tool

You can use the Viewer Compare tool to compare the active document with another document.

To compare the active job:

1. Goto Window > Esko > Viewer > Compare...

The Compare dialog opens, and the name for the Current Document is shown.

Compare
— Documents to Compare { OK ]
—
Current Document: file2.ai pr—
( e . | [ Cancel )
Compare To: filel.ai = ] (' Browse... |

Compare What: Entire Document

2. Select the file you want to compare the active document to:

If you want to compare it to an open document, select its file name from the dropdown list
If you want to compare it to a document on disk, click the browse button and select the file

3. Define what to compare:

all artwork

the current Artboard

only Trim Box or Media Box (if they are defined)
only the selected area.

4. Click OK

A Viewer Compare window will open, showing a comparison between the two jobs.

Note:

If you have a Trim Box defined in the lllustrator job, the Viewer Compare tool will only show what’s
inside the trim box.

6.1 The Viewer Compare window

24

The Viewer Compare window shows the two jobs and their differences, and contains a number of
tools and buttons to inspect these differences in various ways.

Move over a button with the cursor and the tooltip will indicate what it stands for.

Buttons with a triangle in the lower right corner contain additional options: Control-click (Windows)
or Command-click (Mac) the button, or click and hold the button to see the extra options.
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6.2 Navigating the Viewer Compare window

The Viewer Compare window contains different ways to navigate:

The Inspect tools

Q Q @

e The Zoom tool. Under the zoom tool you find

e Zoom out

¢ Fit document in view

¢ Fit document width / height

e Zoom to 1:1 view

e Show Zoom Options (showing all these options as individual buttons)
¢ The Zoom out tool
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e The Pan tool

The Navigator

By dragging the red rectangle (when zoomed in), you can navigate through the job.

The View options

The View options allow to go back to the previous view, or use additional settings, such as rotate,
invert or mirror the view.

6.3 Compare modes

Using the Compare butons, you can choose different Compare modes / views

Compare

) ‘wm &) om gy

¢ View Current version only
¢ View Reference version only
¢ View Both documents on top of each other.

Additional options:
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¢ View Both in their original colors

¢ View Both - Show difference: the differences will be shown in the "Added" and "Substracted"
highlight colors.

¢ View Both - highlight difference: same as above, but the identical parts are dimmed.

¢ View Both - only difference: same as above, but the identical parts are hidden.

e Change "Added" Highlight Color, Change "Substracted" Highlight Color and Change Both
Highlight Color, to change the colors in which differences are shown

¢ Reset Difference Highlight Colors to reset the default colors
¢ Channel Matching, to match corresponding channels/inks for the two documents.
¢ View Both - side by side shows both versions next to each other. You can choose between

¢ Automatic tiling
e Horizontal tiling
¢ Vertical tiling.
e View both - mirror reference shows the current document on top of the mirrored reference
document.

6.4 Alignment

Comparing files with different sizes may seem like a challenge as they are not aligned in the Viewer
Compare window, but it provides some tools that make it very easy.

Alignment: [:] Offset X,¥:| 0.0 0.0 mim

e Alignment

e on one of 9 corner / center points
¢ Align From Ruler: see Align from Ruler
¢ Auto Align From Ruler: see Auto Align from Ruler
¢ Auto Align: see Auto Align
e Auto Align: see Auto Align
¢ Use trim box for alignment
e Offset, Horizontal and Vertical

6.4.1 Align from Ruler

The ruler tool works by defining two points (one in each file) that have to be aligned.
1.

Select the reference version of the file by clicking the icon.

&

a4

Select the Ruler tool
3. Indicate the ruler anchor point
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Switch to the other version by clicking the icon (or use Ctrl + S).

The anchor point, here in the red circle, will be in a different location in the second file version.
5. Indicate the point that should be positioned on the ruler anchor point (here in the blue circle)

Click the Alignment button ~  and select Align From Ruler. The files are now aligned.

Note: Depending on how precisely you defined the second ruler point, you may have to zoom in
and repeat the alignment procedure to align your files with more precision.

6.4.2 Auto Align from Ruler

Auto Align from Ruler is used the same way as the Align from Ruler tool, but is more accurate at
high resolution.
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If the details of the alignment points match, the viewer will be able to increase the alignment precision
(and have a good alignment with fewer iterations).

6.4.3 Auto Align

Auto Align does not use the ruler, but rather the currently visible view of the two compared images
to attempt an automatic alignment.

For convenience, a separate tool button is available to perform an Auto Align operation without having
to open the Alignment pop-up menu. Clicking this button will perform an Auto Align from Ruler if a
ruler selection is active, otherwise an Auto Align (from view).

6.5 Viewer Compare Preferences

You can open the Compare Preferences by choosing lllustrator > Preferences > Esko > Viewer
Compare Preferences (on Mac OS) or Edit > Preferences > Esko > Viewer Compare Preferences
(on Windows).

You can define the resolution for the Viewer Compare previews: either based on the document size,
or at a fixed resolution. "Based on Document Size" will result in a low resolution for big documents,
so e.g. aligning will become more difficult when zooming in. On the other hand, a "Fixed Resolution"
can result in a very heavy preview calculation if the fixed resolution is high and the document is large.

You can define if anti-aliasing should be applied.
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/. Ink Coverage
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With Ink Coverage, you can calculate the ink usage for every ink.

1. Click Window > Esko > Viewer > Ink Coverage... to open the Ink Coverage dialog.

Ink Coverage

" | ! - 1

Scan: | Current Artboard |+ ] ( Calculate -) [ Sawve as XML... )
B Process Cyan 23340.7 mm’  4.4%
B Process Magenta 22147.0 mm?® 4.2%
|:| Process Yellow 39037.3 mm’® 7.4%
B Process Black 8859.2 mm?  1.7%
B PANTONE 300 C 0.0 mm? 0.0%
B PANTONE 7546 C 77383.0 mm? 14.7%
] PANTONE 583 C 147468.4 mm® 27.9%

" Cloca

| Close |

2. In the dropdown, select the area you want to scan. By default, Ink Coverage is calculated on the
Current Artboard

3. Click Calculate

For every separation, the size (in square mm or square inch) and percentage of the total surface
is shown.

Note: By setting the Densitometer Mode to "Rounded" in the Viewer preferences, the values in
the Ink Coverage palette will be rounded off.

4. Click Save as XML... to save the result of the Ink Coverage calculation into an XML file.
5. Click Close to close the Ink Coverage dialog.

Note: Technical inks will not be presented in the list, nor in the exported XML.
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